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Checklist for keeping a stable EndNote library

1. Create a Research folder at the top of your hard drive - usually the C: drive on Windows, or in the
Documents drive on Macs. Save your library there.

Do not store active EndNote files on syncing (OneDrive, Dropbox), networked drives (H: or G: drives)
or Time Machine for Macs, as this will eventually corrupt and crash the library.

1. Create a folder at the top of your hard drive for your personal EndNote library and Word
documents. Make sure that the folder is not part of your syncing system for backing up your files.
2. Create your new EndNote library and save it to this folder.

EN New Reference Library X
4 = > ThisPC > Documents > v O Search Documents P

Organize ~ New folder = -

Name Date modified Type Si

= This PC

-B 3D Objects Custom Office Templates 12110
@ Desktop &' My Music 110

| Documents #- My Pictures 110
& Downloads & My Videos G
P Music

& Pictures

B videos

. Windows (C)

=~ SABRINA (D7)
v < >

[ZENET My EndNote Library.enl| v

Save as type: | EndNote Library (*.enl) 3

~ Hide Folders Cancel

2. Save your Word documents to the Research folder.

e EndNote creates links to Word documents. If you move the file, the links may be broken
between EndNote and Word and strange things may happen to your bibliography and in-text
references.

e Having all of your Word documents in the same place also makes it very easy to back
everything up.

o Write your chapters in separate Word files. Large files slow down Word performance. We
can help you combine them later.

3. Regularly manually back up your library and Word documents
Regularly copy your research folder to another portable storage device such as a backup drive.
This backs up your Word files as well.

4. Sync for automatic backups with EndNote online (EndNote Web)

EndNote Sync enables you to access your research on the Web and on other computers with EndNote 21.
If you use more than one computer, or use a Mac and Windows at different locations, this is an ideal way
to make sure each computer’s library is kept current.

Sync can automatically backup your EndNote references and attachments, but not your Word documents.

5. Sync between Windows and Mac

If you use Windows computers on campus and a Mac at home, use EndNote Sync to share your library
easily between the two computers and platforms.
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Getting Started

1. Type the word ‘EndNote’ into the search box of your Windows toolbar.
2. Click the EndNote apps.

File Edit References Groups Tags Library Tools Window Help

Set up EndNote Library

If you already have an EndNote library, please locate it and we’'ll get it set up.

Open an existing library

Alternatively, you can start from scratch with a new library.

Create a new library

3. If you have used EndNote 20 previously, click “Open an existing library” from the starter screen.
Older libraries may need to be converted. Follow the prompts.

4. If you haven't used EndNote before, you will be presented with a box prompting you to set up a
new EndNote Library. Click “Create a new library”.

5. EndNote presents a window prompting you to name and save the new library. We need to create
a folder on the hard drive for your research. Click the new folder to select it. (Do not save to
OneDrive, Dropbox or other syncing drives or the library will get damaged.)

6. Change the save name if required. The extension “.enl” stands for “EndNote Library”. EndNote

will add “.enl” automatically.

Click Save.

8. The new empty library will open in EndNote 21.

N
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Adding references to your database

We recommend Firefox or Chrome browsers for searching our databases and transferring records to
EndNote 21.

You can search Swinburne Sarawak library databases and then export the search results to EndNote.
You will need to sign in using your OpenAthens account. Typically, Swinburne Sarawak Library

databases will have an option to “mark” or “add” records of interest, and then you can look at the marked

items and find an export option.

You may need to do some editing after the export.

+ Exporting references from Bibliographic Databases: an example

1. Make sure that you have your EndNote library open.

Go to the Library homepage http://www.swinburne.edu.my/library

A link for Science Direct appears under the Library search box. Click the Science Direct link.
Login with your OpenAthens account.
Type the words: rainfall and "stormwater runoff” in the search window.

Click Search.

N o o M w® DN

You will get a list of all relevant articles. To mark articles of interest:

a. For one useful reference, you can click on the selection box. Then click the Export
dropdown arrow and click the Export citation to RIS link.

" Recent download history x

Brought to you by: Swinburne Library SelenceDirect atations 1723015462077 1

b 8 e ago
S ScienceDirec ournals & Books Help kel " 2
"B ScienceDirect ! © s p o

Find articles with these terms

rainfall and "stormwater runoff" B

¥ Advanced search

3,818 results T2 Downlood 1article A Export sorted by relevance | date
‘ Compare individual and combined bioretention systems on the reduction of thermal pollution from stormwater runoff
ur Management, September 2024
Refine by: Click to add a |Mengai sun, junaiti, Yangmo zhu
[ subscribed journals Sing|e record | vieweDF  Abstract v Grophical Abstract v Figures v Export

Export

» Save to Refworks

> Export citation to RIS

2> Exportcitation to BibTeX

> Exportcitation to text

Article type (@

[[] review artictes
[ research artic

|:| Encyclopedia (S Lilia Ochoa, Julianne Chan, ... N. L. Fahrenfeld

(] ook chopters 262) #%) View PDF__ Abstract ~  Graphical Abstract v Figures % Export
8. Click the file at the bottom left corner.

[[] Researcharticle ® open access

2 Stormwater runoff microplastics: Polymer types, particle size, and factors controlling loading rates
cience of The Total Environment, 15 June 2024

9. This should then prompt the transfer windows, or save on the taskbar below the Windows,
Click the file or open the file directly in EndNote.

10. EndNote 21 should transfer the records directly to your current library. If it doesn't, use the
Look in the dropdown menu to find and click on your library file.
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11. The references will be transferred to your library as an Imported references group. Note
that exported references do not include full text.

Mac transfer: You may need to click Choose... and point to EndNote 21 in your Applications folder.

12. Click OK.

13. You may see a second “Choose destination” window if you also use EndNote Online. Click
EndNote and OK.

14. If you don't see a transfer window at step 8, the file may automatically be saved to your
Downloads folder (depending on your browser settings.)
» Chrome for Windows and Firefox for Mac has an arrow icon in the menu bar you can click to
find the file.
» Chrome for Mac saves the file to a menu bar at the bottom of the screen.
« Otherwise use your File Explorer to locate the .ciw file and click it. This should then prompt the
transfer window or open the file directly in EndNote.

Search o
lja savedrecs.ciw
. = Completed — 98.6 kB

Show All Downloads

[}

15. EndNote 21 should transfer the records directly to your current library. Some Macs will
request you point to the required library.

16. The references will be transferred to your library as an Imported references group. Note this does
not retrieve the full text of the article.

iguration Imported References

m

All References

Author ~ || Contains ~

(® Imported References
A Recently Added And ~ || Year ~ || Contains ~
B Unfiled 2 And ~ || Title ~ || Contains v
W Trash
Simple search
v MY GROUPS
@& E-Learning
v My Groups Imported References
MY TAGS Reference
B For Review Author Title [ Year { Journal
Urgent
=t Mishra, Vrij Kishor; Gup...  E-Learning Impact on Technological Perspectives in Library S... Rejuvenating Libraries in Modern S...

FIND FULL TEXT

GROUPS SHARED BY O...
ONLINE SEARCH +
@ Jisc Library Hub Discover
@ Library

@ PubMed (

@ Web of Scienc
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- Exporting references from the Swinburne search page: an exercise

1. Make sure that you have your EndNote library open.

Go to the Library homepage: https://www.swinburne.edu.my/library

Type your search terms in the search window.
Hit Enter.

Go to the title you are interested in and click on it.

o e B 0N

Go to the Tools menu on your right and click Cite, then select Export citation.

® WyEssco

Stormwater Runoff Pollutant Loading Distributions and Their Correlation with Rainfall and Catchment Characteristics in a Rapidly Industrialized City ® Q

€ Results a @ B e+ &

My dashboard @ Peer reviewed | Artide m
Stormwater Runoff Pollutant Loading Distributions and Their

M Overview - . . Py .
Correlation with Rainfall and Catchment Characteristics in a
& Projects Rapidly Industrialized City.
[ Saved Published in: PLoS ONE, Mar2015
Database: Academic Search Complete
[ Searches By: Li, Dongya; Wan, Jinquan; Ma, Yongwen; Wang, Yan; +2 more
@  viewed
Access options I [ & Download ]
& journal alerts
Research tools

Details More like this

@ New search

3 Publications

‘Additional information
-5 Concept map

Title

&

Stormwater Runoff Pollutant Loading Distributions and Their Correlation with Rainfall and
Catchment Characteristics in a Rapidly Industrialized City.

Supplemental sources

Links

Home Authors

Library Website a
n'2 ppjqwan@scut edu.cn

Ma, Yongwen'-

Article

Stormwater Runoff Pollutant Loading
Distributions and Their Correlation with Rainfall
and Catchment Characteristics in a Rapidly
Industrialized City.

Li, Dangya; Wan, Jinguan; Ma, Yongwen;
2015

i copycitation B Export citation

Export to your citation ool of choice.

Expart to EasyBib
Expart to RefWarks

Export in RIS format (e.g. CITAVL, EasyBib, EndNote, Mendeley, NoodleTools, ProCite,

Refwarks, Zotero, etc.)
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7. Choose Direct Export in RIS Format (e.g. CITAVI, EasyBib, EndNote, Mendeley, ProCite,
RefWorks Reference Manager, Zotero, etc).

8. Click Save.

9. Double-click on the file to open it in the Endnote application. (To do this, please open the
EndNote Library application in advance)
10. The records will be transferred to EndNote.

11. EndNote 21 should transfer the records directly to your current library. If it doesn't, use the

Look in dropdown menu to find and click on your library file.

12. The references will be transferred to your library as an Imported references group.

Imported References

Author ~ || Contains ~

And Year || Contains v

And Title Contains

v 201... Summary oF & B X

+ Attach file
un

oading
rrelation with Rainfall

Imported References

Author
Dong

ics in a Rapidly

D. Li.J. Wan, Y. Ma, Y. Wang. M. Huang and Y. Chen

PLS ONE 2015 Vol. 10 Issue 3 Pages 1-17

DOI: 10.1371/journal pone 0118776
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- Looking at your EndNote library

When you have transferred your records, you see the EndNote 21 Library window. The newly imported references are displayed on the summary screen.

The Groups panel shows default
| library groups and group/group sets
you created for your research projects.

Use Advanced Search to query a specific
field or craft a multi-parameter search. Switch
to Simple Search to search all fields.

All References

All References

. Author ~
Imported References

Contains

The Summary screen displays vital reference
details. Alter data from the Edit screen or
read an article from the PDF screen.

.., 202... Summary F &~ x

+ [+ [+
X[ X| X

And ~ || Year ~ || Contains ~
and ~ [ Tite ~ | [ Contains ~ T The influence of e-learning.pdf
h fill
Simple search Search options
MY GROUPS
— The Infl of E-l ing Beh on Students’
8 E-Learning Learning Performance of Disaster Emergency
~ My Groups All References @ @ Knowledge
* MY TAGS 0 References
Y. Zou, L. Shen and S. Dadparvar
B For Re y
Author Title [ Year I Journal [ Last Updated | Reference Type
Urgent i i
gen Ebbesen, TW; Lezec, HJ.. Electrical conductivity of individual carbon nanotubes 1996 Nature 7/8/2024 Journal Article \mern.ahoﬁa\ Journal of Emerging Technologies in
FIND FULL TEXT Learning (JET) 2022 Vol. 17 Issue 01 Pages 49-59
H5P Getting started 2024 16/7/2024 Web Page
GROUPS SHARED BY O...
Kami J. Silk, Evan K. Per...  The effectiveness of online versus in-[erson library instruct... 2015 The Journal of Academic Librariansh...  23/7/2024 Journal Article DOI: 10.3991/ijet.v17i01.28475
ONLINE SEARCH +
Li, Dongya; Wan, Jinqua... Stormwater Runoff Pollutant Loading Distributions and Th.. 2015 PLoS ONE 7/8/2024 Journal Article
Montana-Blasco, Mireia. Perceptions of online education among 16-18-year-olds| = 2023 El Profesional de la informacion 15/7/2024 Journal Article
Pinto, Maria; Caballero ..  Experiences of information literacy and mobile technologies .. 2021 Aslib Journal of Information Manag...  15/7/2024 Journal Article APA Tth v ert Copy v
Sorgo, Andrej; Bartol, T Attributes of digital natives as predictors of information fjter.. 2017 British Journal of Educational Techn..  15/7/2024 Journal Article
Debby R. Wegener Information literacy: Making asynchronous learning more eff.. 2021 The Journal of Academic Librariansh... 23/7/2024 Journal Article Zou, Y., Shen, L., 8 Dadparvar, 5. (2022). The Influence of
E-lea Behavior on Students’ Leal
Wema, Evans F. Developing information literacy courses for students throug... 2021 IFLA Journal 15/7/2024 Journal Article g Soron S e s earming
Performance of Disaster Emergency Knowledge.
Zou, Yixuan; Shen, Laiji...  The Influence of E-learning Behavior on Students’ Learni}'lg P.. 2022 International Journal of Emerging T...  15/7/2024 Journal Article International Journal of Emerging Technologies in

The tags system provides a new ability to

Learning (UET), 17(
1

https://doi.org,

, 49-59.

visualize sub-topics in your library groups or

provides an alternate organization system.
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EndNote's Preferences setup can be found in the EndNote 21 menu (Mac) or Edit Menu (Windows).
The File dropdown menu:
e Open, close, save and create EndNote libraries.
e Import individual PDFs or folders of PDFs - EndNote will attempt to find the bibliographic
data for you.
e Make a compressed backup. (Limited to libraries of less than 4 GB in size and/or 65,535 files)

The References menu:
e C(Create, edit and delete references.
¢ Find Reference Updates - search for missing information.
o Find full text from a limited set of resources.
e Reference summary -see which groups it is assigned to.

The Groups menu:

e (Create, rename, edit and delete groups, which are a method of sorting your references.

e Group - organize your references by various topics.

e Group set - organize your numerous groups into sets. When we use the ‘Find Full text’ feature,
EndNote will automatically create a Group set with 3 Groups titled ‘Found PDF’, ‘Found URL’,
and ‘Not Found'.

e Smart Groups - automatically add references to a group with specific criteria.

B New Group Vv New Group Set (@) New Smart Group

&\ New Group

The Tags menu:
e A new feature for EndNote 21.
e Customizable labels with color coding as an alternate option to organize and classify
references.
e Tag will appear next to the title of the article.

Create Tag = All References
Author Title [ Year | Journal
L (2 Ebbesen, TW; Lezec, H)...  Electrical conductivity of individual carbon nanotubes 1996 Nature
Orange HsP Getting started 2024
Tellow Kammi J. Silk, Evan K. Per.. The effectiveness of online versus in-[erson library instruct..® 2015 The Journal of Academic Librariansh.
Green Li, Dongya; Wan, Jinqua Stormwater Runoff Pollutant Loading Distributions and Th.. ® 2015 PLoS ONE
™ Slue Montafia-Blasco, Mireia... Perceptions of online education among 16-18-year-olds: ... ® 2023 El Profesional de la informacién
b Purple Pinto, Maria; Caballero ...  Experiences of information literacy and mobile technologies 2021 Aslib Journal of Information Manag
Gray Scrgo, Andrej; Bartol, T. Attributes of digital natives as predictors of information liter.. 2017 British Journal of Educational Techn..
Debby R. Wegener Information literacy: Making asynchronous learning more eff.. 2021 The Journal of Academic Librariansh
Wema, Evans F Developing information literacy courses for students throug.. 2021 IFLA Journal

The Library menu:
e Manually sync your library.
e Find duplicates.
¢ Find/Replace and Change/Move/Copy fields.

The Tools menu:
o Edit the output styles that format the display of references.

You may need to make some changes to newly transferred references. Use the reference quick edit tab
at the right of your screen and save the change.
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- Using the Edit panel

Sometimes references do not export smoothly from a database. You can make changes in the Edit
window.

An example would be a newspaper article from EBSCOhost. Those articles are exported as a Generic
Reference type instead of a Newspaper article. It won't look right in the preview panel or your
bibliography until you correct it.

1. Click the Edit section on the Reference pane.

2 Click the Reference type dropdown menu, which may currently show “Generic”.
3. Select Newspaper Article
4

You need to move the newspaper title and other details to the correct fields. Check the Notes
field for missing information.

5. Click the Save button.

- Adding some keywords

EndNote's basic search function lets you search in all fields, including PDFs. However, we recommend
you add some descriptive words to the Keywords field to remind yourself of the important topics
discussed in the article.
e Put them on separate lines so that EndNote will recognise each separate keyword.
o EndNote gathers a keyword term list and will autosuggest words from the list if you start to
type in a similar word. Type over an autosuggestion if you need to use a new keyword.
¢ Using the same keywords in articles on the same topics will make it easy for you to use the
Quick Search function to find similar articles.

- Finding full text for a reference

EndNote can attempt to locate full text files from these sources on the Web:
e Web of Knowledge Full Text Links
e DOI (Digital Object Identifier)
e PubMed LinkOut - for medical and science resources

If found, EndNote downloads and attaches the files to the references. You can search for up to 250
records at a time.

To search for the full text:
1. Highlight the references you want to check. (click one record and Command-A for Mac, or
Control-A for Windows)
2. Click the Find full text icon in the toolbar.
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Al References

Advanced search

99 @

MY GROUPS

Title | Last Updated | Reference Type

rference Series. Earth and En 4

i media. ® mputer S

~ MY TAGS
»
. 3 Multiple lift
v FIND FULL TEXT , y, A “From the beginning. | think it @ stretch™~teach.
v GROUPS SHARED BY O. ge for leaming: Rebalas g gni
~ ONLINE SEARCH

st Ozan Oner
Rihanat Idowu Abdulka

chank, Rog

Journal Artic

Imported References

75 R

Title

MY TAGS An analysis on the cultural contexts of BLATI

FIND FULL TEXT 2023 Kinesthetic empathic witnessing in relation 1
Influence of Dance C on the Oy ity
The Effect of Ten-week Ballroom Dance The

Barna, L: Pucs A . 202 The Effect of Ten-week Ballroom Dance The
T ur

GROUPS SHARED BY O
ONLINE SEARCH

Beaudr : 4 - 20: Adapting Dance to
Food for Dance
Abstracts from t 022 Research and Thesi
An Automatic Music-Driven Folk Dance Moy
Dancing in silence in premodemn Europe
Dance Participation during the COVID-19 Pa
Parenting, Roma feminis

Dancing upon the abys
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+ Manually adding full text articles and other attachments

If EndNote cannot automatically retrieve the full text, you can manually add the full text from files on
your computer.

1. Click to select the record.

2. Click the “Attach file” button in the Summary panel.

3. Find the PDF or other format file on your computer.

4. Click Open. The file will be copied to your EndNote reference and library.

= Bor.., 2009 #7 Summary Edit Z &
Advanced search
99 QB @ | Meomrebremmseciuome
S. P. Borgatti, A. Mehra, D. ). Brass and G. Labianca
I Title i Journal ] Last Updated I Reference Type

Climate Change, Global Warming and Global Inequi..  10P Conference Series. Earth and En._  18/6/2024 Journal Article TEMACH 2000 Vol 323 Inua 5016 Pades 852095
Effect of visual imagery in COVID-19 social media Peer) Computer Science 15/2/2023 Journal Article
Network analysis in the social sciences science 15/2/2023 Journal Article
Network analysis in the social sciences science 15/2/2023 Journal Article
Social network analysis to study health behavioursi..  Social Science & Medicine 15/2/2023 Journal Article Manage tags
The engineering handbook 15/9/2023 Book
How the Impact of Social Media Influencer Disclosu Journal of Advertising Research 16/1/2023 Journal Article
The practical impl 1 of artificial intellig, Nature medicine 1/2/2024 Journal Article
Multiple lift DC-DC boost converter using CLC cell ®  Australian Journal of Electrical and E 24/3/2024 Journal Article
“From the beginning, | think it was a stretch™-teach English Teaching: Practice & Critique 20/11/2023 Journal Article
A metalanguage for leaming: Rebalancing the cogni... Frontiers in Communication 20/11/2023 Journal Article
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+ Importing PDFs from your files

EndNote 21 can also import folders of PDFs you already have and attempt to find the bibliographic
(publication) information for the more recently published articles.

To import a folder of saved PDFs:

Open your EndNote library.

Click on File >Import.> Folder > Choose

Find the folder of PDFs and click on it.

Click OK.

Check the Duplicates option. Select your preference.

Click Import.

Any PDFs with embedded DOI data will be imported to new records with basic bibliographic data.
All others will be added to individual default journal article records and the file name of the PDF
will be listed in the title field. You will need to manually add bibliographic data for those
references.

S A Ol

c Configuration [ ]
BaAl e Advanced search
MImported References 10
ently Added Imported References
; meors 32"
Author Year Title Rating Journal lastUpd.. Reference Type
v MY GROUPS
Mt Ross 2010  Parental Depression and Divorce and Adult Chil... Journal of Child and Family Studies 2/12/2020  Journal Article
~ My thesis
®Bib <143.pdf> 2/12/2020  Journal Article
Taylor 2009  Parental Depression in the Context of Diverce a... Journal of Divorce & Remarriage 2/12/2020  Journal Article
Stallman 2014 A Randomized Controlled Trial of Family Transiti... Journal of Divorce & Remarriage 2/12/2020  Journal Article
~ My Groups
& <renaming mpd.pdf> 2/12/2020  Journal Article
[--LEE
<mohr 2002.pdf> 2/12/2020  Journal Article
Brown 2014  Filicide and Parental Separation and Divorce Child Abuse Review 2/12/2020  Journal Article
<elbogen 2009.pdf> 2/12/2020  Journal Article
B need full te
Gray 2016 ‘I'm Working Towards Getting Back Together”: C... Child Abuse Review 2/12/2020  Journal Article
VFIND FULL TEXT
& Found URL Romere-Lopez 2016  Una revision de los trastornos disociativos; de la... Anales de Psicologia 2/12/2020  Journal Article

If you choose to import duplicates to a duplicate library, EndNote will create one and report the number
of standard and duplicate imports. Note that after the transfer, EndNote may display the duplicate library
- it is important to check the library’s file name at the top of the screen.

+ Opening attached PDFs

1. Click the reference to select it.
2. Attachments are listed at the top of the Summary panel. Click to see your options to open the
attachment within EndNote, Adobe Acrobat or rename the file.
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« Searching your library

Click All References to make sure you are searching for the whole library.
There are two ways to search your library:

1. The quick search field at the top of the reference window - a simple search for a keyword or
author name.

2. The Advanced search link to search for a combination of terms or search in other fields or the PDF
or sticky notes.

If you want to search the contents and sticky note comments of your PDFs, you must do an advanced
search. You can then set the search field to “Select the Any Field + PDF with Notes” option from the Field
list. You may need to scroll up.

The references found in the last search operation are saved in a temporary Search Results group. When
you close the library or run another search, this temporary group is discarded.

+ Managing your references: Creating groups

Groups make it easy to organise a large library into folders or subsets for later access. You might want
to create a group to gather the research materials for a particular assignment or journal article. Some
researchers use groups to collect resources for each chapter in their thesis.

Tip: Create a group to collect any imported items that you do not currently have in print or electronic
full text in your research collection. This will make it easier to identify items that need to be obtained
by interlibrary loan.

Click the Groups dropdown menu.
Click on Create new group.
Call the new group Need fulltext and hit Enter.
Click the Not Found group that resulted from the Find Full Text search.
Ctrl-A to select all of the references if they aren’t already highlighted.
You can add the highlighted references to the group in several ways:
i. Drag and drop them onto the group Find Full Text.
ii. Click the Groups dropdown menu, click Add References To, and select the group Need
fulltext.
iii. Right-click on a selected item, click Add References To, and select the group Need fulltext.
7. Click on the group name to see its contents.
e You can add a reference to a particular group only once. However, you can add that
reference to any number of groups.
o Deleting a reference from a custom group does not delete it from the library.
e Deleting a reference from a library also deletes it from all groups in that library.
e Want to see which groups you have put a reference in? Click the reference, then click
References > Reference summary.

cOorWON -~
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Setting up EndNote sync for auto backup

- Syncing to a new EndNote online account

EndNote 21 gives you the ability to automatically back up references via EndNote online
http://www.myendnoteweb.com/ and sync across two or more computers. You can also share the entire
library via 21 or just a group (or selected groups) via EndNote online with fellow researchers. Information
about sharing groups or libraries is available on our website.

e You can sync one library with up to 1,000,000 references, 5000 groups and unlimited attachments.

e Please only do this on your own computer.

e Note: You can only link one library to an EndNote online account. This online account will then “lock”
to that computer's copy of the EndNote software. You will not be able to work with more than one
synced account per personal computer or per login on Swinburne computers.

1.  Click the Sync configuration in the groups panel.

ps Tags Librar Window Help

All References +

Author v || Contains v
And ~ || Year v || Contains ~
And ~ Title v Contains
W Trash
v MY GROUPS

All References
v MY TAGS Referen:

B For Review

Author Title

Urgent
“ FIND FULL TEXT
“ GROUPS SHARED BY O...
v ONLINE SEARCH +

Ebbesen, TW; Lezec, HJ. Electrical condu
H5P Getting started

Kami J. Silk, Evan K. Per...  The effectivenes|
Li, Dongya; Wan, Jinqua. Stormwater Run:
Montafia-Blasco, Mireia.. Perceptions of of
Pinto, Maria; Caballero ..  Experiences of i

Sorgo, Andrej; Bartol, ... Attributes of dig

Debby R Wegener Information liter]

2. Click Sync Now.
Starting from EndNote 21 will get you a full-service EndNote online account. Going directly to the
website gets you only a basic account.

Have an EndNote online account already?

Type your existing EndNote online login and password into the EndNote Account Credentials fields
and click OK.

Don't have an EndNote online account?

a. Click Sign Up.

b. Type in your preferred email: it does not have to be your Swinburne email.
c. Complete the registration process.

3. The Sync system will authorise your new account and add the details to EndNote 21. The library will
automatically sync every 15 minutes and when you close the library. Change the settings in the
Preferences > Sync screen if required.

4. If you have references in the library, you will be asked to make a compressed backup. Follow the
instructions to do so.

5. The first sync can take a long time, especially if you have many references with full text. Please be
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patient - future syncing will be much quicker.

6. EndNote 21 and EndNote online will now sync automatically. Please remember to regularly back up
your Word documents.

« Syncing an existing account to a second computer (Mac or Windows)

These instructions assume you have already created and synced a library on the first machine.
Open EndNote 21 on the second computer (Mac or Windows).

Click File.

Click New.

Create a new library.

Library > Sync in the menu.

coprpwN =

File Edit Refe Groups Tags REBIELE Tools Window Help

< Sync Configuration Sync

[ All References Advanced Search Ctri+Alt+F |

2 Recently Added sort Library.
8 Unfiled

W Trash Find Broken Attachment Links

MY GROUPS Remove Broken Attachment Links...

v My Groups

Open Term Lists v

MY TAGS - E
Define Term Lists... Ctri+4
FIND FULL TEXT
Link Term Lists. Ctri+3
v GROUPS SHARED ... w
> ONLINE SEARCH + ' .

7. Type your existing EndNote online login and password into the EndNote Account Credentials fields.
8. Click OK.

9. The library will automatically sync every 15 minutes and when you close the library. Change the
settings in the Preferences > Sync screen below if required.
(Edit > Preferences > Sync for Windows or EndNote > Preferences > Sync for Mac)

10. Click OK to close the Preferences screen.

The synced library's references, attachments and groups will be added to the library on your second
machine. Your computers will now sync to EndNote online and update automatically. Please remember to
regularly back up your Word documents.
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Simple bibliographies

EndNote's Cite While You Write (CWYW) feature is a powerful tool that allows you to create “live”
bibliographies that update when you insert references into your text. However, it can cause corruption
in your Word documents if used incorrectly.

Sometimes you might want to produce a bibliography or reference list quickly without using CWYW.
We call this a simple bibliography and it is quick to generate and add to an existing document.

1. Make sure the citation style you wish to use is active in EndNote (see pages 20-21)

2. Control-click (Win) or Command-click (Mac) to highlight the articles you want to use or
. Add all of the relevant references to a group
. Click one of the references within that group
. Ctrl-A or Command-A to select all-ef the group

3. Click Copy Citation at the bottom of the summary panel.

4, Paste the list to your Word document. This will create a formatted bibliography without linking to
EndNote. The new bibliography may need its font or spacing to be changed to match the rest of
the document.

5. Any corrections you make to the bibliography are only for this document.

When should | use Cite While You Write?

EndNote's Cite While You Write (CWYW) feature is a powerful tool that allows you to create “live”
bibliographies that update when you insert references into your text. However, it can cause corruption
in your Word documents if used incorrectly.

1. CWYW involves complex code that will be corrupted if you incorrectly move or delete those
references. This can lead to bibliographies failing to format properly later, or the wrong references
appearing in the paper.

2. It can also conflict with Track Changes, another feature of Word used frequently by supervisors and
collaborating authors.

3. You need to either use the powerful features of Cite While You Write correctly from the beginning or
insert them at the end of the writing process when you have finalised the content of your paper and
have accepted or rejected all tracked changes.

We recommend two options while you are in the writing stage: place markers or unformatted citations.

1. Use plain text to put in “placemarkers.” A placemarker such as <<Jones and Wade, 2015 pg12>> can
be safely moved or deleted. You can find the placemarkers easily by using Control-F and searching
for << and replace them with formatted citations when the paper is at the final stages of completion.

2. Use unformatted citations. These use EndNote code to identify the reference in your EndNote library,
but the code is not active and can be safely moved or deleted.
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An unformatted citation looks like this:

Click the EndNote 21 tab in Word.

If Instant formatting is turned on, click to turn it off.

If you have formatted CWYW citations, click Convert Citations and Bibliography.

If you are using a Mac, find your Convert options in the Tools dropdown tab.

If you need to see the formatted references, click Update Citations and Bibliography. Remember to
unformat them afterward.

®Pao0oco

Outline-EndNote 21.docx - Word

File Home Insert Design Layout References Mailings Review View Help EndNote 21 Acrobat Q Tell me what you want to do
|,,| EN Go to EndNote Style: =] Export to EndNote ~ e
[ Edit & Manage Citation(s) [5} Update Citations and Bibliography Instant Formatting is Off = [l Manuscript Matcher
Help

Insert =y .. ..
G L",, Edit Library Reference(s)

Harvard Lo

@\Conver‘t Citations and Bibliography — Preferences

Citations Bibliography = Tools

With EndNote 21, Cite While You Write is now compatible with Google Docs for EndNote 21, besides
Microsoft Word or Apple Pages documents. You will need to install the EndNote 21 Cite While You
Write in Google Workspace Marketplace, and then login with your EndNote Web account.

= O Google Workspace Marketplace Q @] i m

(&) Home

oo Recommended for Gao... . .
EndNote 21 Cite Whil... [ e |
I Editor's cholce
Insert in-text citations while simultaneously creating a
bikliegraphy with the Cite While You Write™ feature in
Intelligent apps Google Docs™.

By: Clarivate
Listing updated: June 25, 2024

Work from everywhere
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I’'m ready to use Cite While You Write. Now what?

+ What are output styles?
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An output style determines how the selected reference will be formatted and displayed in Word. You will
be able to concentrate on writing your essay or thesis, with the knowledge that EndNote will handle the
correct punctuation and formatting of your references.

Please check with your department to see if there is a preferred style.

If you need a style such as APA 7™, Chicago A or B, Nature, IEEE, or many others, EndNote 21 has almost

500 included styles.

« Activating a style within EndNote

1.
2. Ifthe style you want is not listed, click Select another style.
3. Scroll through and click the style you wish to activate.
4. Click the Style Info/Preview button if you want to see a sample bibliography.
5. Click Choose. The style is now available and active within EndNote.
Choose A Style ]
I Name Category
Current Opinion Drug Disc Dev Pharmacology
Current Opinion Immunology Immunalogy
| Current Opinion Invest Drugs Pharmacology

Current Opinion Lipid Endocrinclogy

Current Opinion Mol Ther Pharmacology

Current Opirson Otolaryn Otolaryngology

Current Opinson Plant Bio Biology

Cytokine Growth Fact Rev Immunclogy

Demography Sodiology

Drug Resis tance Updates S-'humuoloqv

Earth Planet Sci Letters Astronomy -

ick Searct - Findby *
£ Less Info: | Style InfofPreview concel | [ choose |

File Name: Developmental Biology.ens
Created: Thursday, 10 November 2015, 11:41:01 AM
Modified: Wednesday, 20 October 2010, 11:42:22 AM
Based On: Elsevier Style #2
Category: Biology

Comments: |This style is Elsevier St:,-le #2, author/date systemn,

Author Notes: Should vou wish to cite a source on the

|Showing 497 of 497 output styles,
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+ What if the style is not included in EndNote?

Some departments require the Swinburne Harvard style, based on our online Swinburne Harvard Style
Guide. The Harvard style included with EndNote does not match Swinburne's Harvard style.

We will download the Swinburne style to practice downloading and activating styles.

First, we need to set up a folder on your computer to which we can save the file. This is required for
EndNote to locate new styles, as set in the Preferences.

coprwN~

Open Windows Explorer and click Documents.
Right-click and select New > Folder.

Name the new folder EndNote.

Double-click the EndNote folder.

Right-click and select New > Folder.

Name the new folder Styles.

Now we can find and save the Swinburne Harvard style.

7.
8.
9

10.
11.
12.
13.
14.

Go to the library's EndNote page at https://www.swinburne.edu.my/library/referencing/endnote-2.php
Scroll to the Swinburne Harvard Style output style box.

Click on the installation link for the Swinburne Harvard style.

You should be offered a chance to open or save the file. Click Save.

Click OK.

Select the C:/Documents/EndNote/Styles folder.

Click Save.

You will need to activate the style in EndNote or Word in order to use it.

If you need a specialist journal style, for example, the CSIRQO's biology style, the EndNote website hosts
thousands of styles.

Al

Go to http://endnote.com/downloads/styles

Type in the style or journal name.

Click Apply.

Click the download link for your style.

Then follow the steps above to save the style to the C:/Documents/EndNote/Styles folder.
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+ Changing a style within Word

When you install EndNote 21 onto your computer, it automatically adds the necessary EndNote tab to the
tools in your Word software. Click on the EndNote 21 tab.

The style shown is usually the style you activated in EndNote 21.

H © - Document1 - Word

File Home Insert Draw Design Layout References Mailings Review View Help EndNote 21 Acrobat
|,, 1 ENGo to EndNote Style: |har\rardswin 'I @-Categorize References ~ Export to EndNote ~ e
F’," Edit & Manage Citation(s) |__=,I Update Citations and Bibliography Instant Formatting is Off - I0U Manuscript Matcher
CiLz:i‘:J: . Fﬁ- Edit Library Reference(s) [ Convert Citations and Bibliography ~ E Preferences Help
Citations Bibliography R Tools

If you need to change to another style for this document.
o Click Select another style.
o C(Click the grey Name header to sort the styles alphabetically.
o C(lick the first style, then type the first couple of letters of the style name to jump down the list.
e Click the style you wish to activate.

EndNote 21 Styles X

Name Category £
Chicago 16th Author-Date Humanities

Chicago 16th Footnote Multidisciplinary

Chicago 17th Author-Date Humanities

Chicago 17th Author-Date Fre... Humanities

Chicago 17th Footnote Humanities

Chicago 17th Footnote French... Humanities
Child Adolescent Social Work Sodal Work
Child Maltreatment Psychology
CIN Nursing v

I

Showing 500 styles from C:\Program Files (x86)\EndNote 21\Styles

e Click OK.

If you need to change the style of your bibliography later, use the Current Style drop down menu on the
EndNote 21 tab to choose an active style or click Select another style to activate a new one. EndNote 21
and Word will automatically reformat your document.
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Using CMYW with Word: an exercise

1. Make sure your EndNote library is open.

2. Open a new Microsoft Word document.

3. Type in the following code to generate some random sentences we can work with:
=rand(2,4)

Press Enter.

Click at the end.
Click Insert Citation.

ocar

Outline-EndNote 21.docx - Word

File Home Insert Design Layout References Mailings Review View Help EndNote 21 Acrobat Q Tell me what you want to do
l,,' N Go to EndNote Style: Harvard - @Categorize References ~ Export to EndNote ~ 0
Q P} Edit & Manage Citation(s) [E! Update Citations and Bibliography Wnstant Formatting is Off ~ ﬂﬂqManuscript Matcher
Insert —— Hel,
Cit:tsieon _ [ Edit Library Reference(s) B2 Convert Citations and Bibliography ~ == Preferences i
Citations Bibliography Tools

7. EndNote displays a Find Citation(s) dialog window.

8. Type an author's last name, keyword or year into the "Search for" box. For this example, type the
phrase drainage.

9. Click Search.

10. EndNote compares the identifying text to your EndNote references and then lists the matching
references. When multiple references match the search, you can identify, highlight, and insert the
appropriate reference.

EndNote 21 Find & Insert My References X

Al v‘ | Find Search: Libraries b

Author Year  Title

Abas 2019.. MUET allows education ministry to gauge English teachers’ proficiency

Abdol Latif 2009 Managing retention in ODL institutions: A case study on Open University Malaysia and Sukhothai Thamn
Abdul 2017  Critical success factors and challenges of women entrepreneurs in Klang Valley, Malaysia

Abdul Sa.. 2008 Refining English language tests for university admission: A Malaysian example

Abdul Talib 2020  Household income and life satisfaction of single mothers in Malaysia

Abdullah 2008 The communicative sensitivity of bilingual socities: Are Malaysia's globalizing tendencies compatible witl
Abdullah 2010  The effectiveness of buddy support system implementation among science teachers: The case of Malaysi:
Abdullah 2019  Implementation of historical thinking skill among Malaysian students using history textbook: concept, is
Abdullah 2011  Writing strategies of Malaysian ESL undergraduate engineering learners

< >

Reference Type Newspaper Article
Record Number 309
Year 2022
Title Innovative IoT modem card from Thales makes it easier to build a 5G world of trust
Newspaper Korea Newswire
Publisher Korea Newswire
Pages 1
Issue Date 24 May v

Insert |~ Cancel Help

Library: My GadNote Library.enl 253 items in list

11. Click on a reference to select it. If several papers might be relevant for an in-text citation, hold
down the Ctrl or Command key and click on the references you wish to cite.
12. Click Insert. A single reference will be inserted into the text within its own bracket; multiple
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references will be inserted into a bracket and sorted according to your chosen output style.

13. Once the bibliography has been generated, the in-text citation will list the papers in an order
specified by your output style.

14. Save the EndNote-connected Word document.

15. Once you have added a formatted citation to the document and updated your bibliography, a
group with the document'’s title will appear in your EndNote library. This group shows all linked
citations within the document and is only available when the document is open and citations are
formatted(Ali, Hamid & Moni 2013).

My EndNote Library.enl

Eile Edit References Groups Tags Li

rrawi@swinburne.edu.my
@ Sync Status 2
B All References

B Swinburne-guide-to... 1
Q Recently Added

& Unfiled

W Trash

16. Want to use unformatted citations during the writing stage? (recommended)

a. Click the EndNote 21 tab in Word.
b. Click Convert to Unformatted Citations.
Note that you will not then have a clickable Word group in EndNote.
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- Changing a reference’s appearance

You can quickly customize a formatted citation's appearance by
e moving the author’'s name out of the brackets
¢ hiding the author's name or date
e or hiding the in-text reference completely

1. Right-click on the citation to select it.
2. Scroll down the pop-up menu to Edit Citation.
3. Click on the option you need.

Video provides a powerful way to help you prove your point. When

paste in the.cahbnlﬁm_ 1 < p o AgNENttO add. You can als

online for the __® ment. To make your doc
B I UW-A-i=-i=- sy

produced, W ver page, and text box d

other [Ahilanj“ =Zansal

For example, ing cover page, header, and sideb

the elements 7y Paste Options: ifferent galleries. Themes and styl

documentcc =, “M click Design and choose a new Th

SmartArt gra pdate Field h your new theme (Han et al., 201

When you ap  Edit Field.. ngs change to match the new the

buttons that  looglefieldCodes  eed them. To change the wayap

it and a buttc A Font. ippears next to it. When you work
want to add = Paragraph.. d then click the plus sign.
"@ Block Authors
Edit Citation(s) B Default Format
Display As: Author (Year)

Ahilan, S., Melville-Shreeve, P., Ka  Frclude Author ). The
Rainwater Harvesting Syst ~ Frclude Year yand S
Efficiency. In G. Mannina(  Exclude Author & Year Drainag
369-374). Springer Interng  Show Only in Bibliography ~ //d0i.0
_1 62 IE" Maore...
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You may wish to modify citations to add pagination details or "see also” references. The following

modifications are available:

Prefix

Add preceding text, such as “Cited in “ Make sure you leave a
space after the text
e.g. the discovery (as cited in Bender, 04)

This can also be used for psychological test abbreviations.
e.g. Strengths and Difficulties Questionnaire (SDQ: Goodman,
1997)

Suffix

Adds the following text. Use this to add page numbers after the
citation. Make sure you put a space before the text
e.g. the discovery (Bender, 04 p.4)

Pages

This field does not work with all output styles. We recommend
you use the Suffix modification instead.

To customise a formatted citation by adding a prefix, suffix or page numbers, or to modify several

citations:

1. Click on the citation to

select it.

2. Click on Edit & Manage Citation(s) in the Word EndNote toolbar.

3. The Edit & Manage Citations dialogue box will be displayed. All the citations within the document
will be listed. Click the citation you want to customise.

4, Customise the citation as needed in the Edit Citations section of the window. If you wish to
change one reference within a group, make sure you click on the reference in the “Citations in
document” window first, to ensure you change the correct reference.

5. Click OK.

« Safely copying text and references between documents

There is a lot of complex hidden code that you don’t see when EndNote and Word work together. That
code can be corrupted if you copy or delete references incorrectly. You can tell if a paragraph has
EndNote code in it. Select the paragraph: EndNote links are highlighted in a dark grey.

On the Inserttab, the galleriesinclude items that are designed to coordinate with the overall look of
your document (Barrios et all 2011).
lists, cover pages, and other document building blocks. _ explains whenyou create
pictures, charts, or diagrams, they also coordinate with your current document look. You can easily

change the formatting of selected textin the document text by choosing a look for the selected text

You can use these galleries to insert tables, headers, footers,
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There is a safe way to copy text with EndNote links to another document.

corLODN -~

Highlight the desired text.

Ctrl-C to copy the text.

Switch to the other document.

On the Home Tab, click the drop down under Paste.
Click the icon for “Paste text” only.

Re-link the EndNote reference.

Home

ol

]

Paste X
o ¥ Format Painte

Paste Options:
=Bl I
Paste Special...

Set Default Paste...

- Safely deleting documents

Please DO NOT delete unwanted citations by highlighting them and hitting the delete key. While doing
so does remove the unwanted citation’s text, it leaves all of the “behind the scenes” coding that allows
EndNote 20 and Word to work together. This orphaned code can cause all sorts of problems later,
including citations appearing out of order, and is hard to fix.

If you wish to remove a citation completely:

1.
2.
3.

5.

Click on the citation to select it.
Click on Edit & Manage Citation(s) in the Word EndNote toolbar.
The Edit & Manage Citation(s) dialogue box will be displayed. All the citations within the

document will be listed. Click the Edit Reference dropdown arrow next to the citation you want to
delete.

Click Remove Citation.

EndNete 21 Edit & Manage Citations X b

Citation Count Library

("Aged Care Act,” 1997)

My EndNote Library | Edit Reference | =
Edit Library Reference
Find Reference Updates... L.
— This is the only safe way to
Insert Citation remove EndNote references.
e e DO NOT hit the delete key!

Click OK.
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Where can | get help with EndNote?

. The Swinburne Library EndNote page: https://www.swinburne.edu.my/library/referencing/endnote.php
Our training videos, training guides, and the Swinburne output style are listed here.

. Clarivate's customer service https://support.clarivate.com/s/ - their online support is quick (during
US business hours) and comprehensive.

. You can download thousands of output styles at https://endnote.com/downloads

° View online tutorials at https://clarivate.com/webofsciencegroup/support/endnote /

Still having trouble? Use our contact form to get expert help from the EndNote team.
http://www.swinburne.edu.au/library/referencing/references-endnote/endnote/endnote-enquiry/
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